


Understanding
Adobe Photoshop CS6

The Essential Techniques for Imaging Professionals

Richard Harrington



Understanding Adobe Photoshop CS6:  
The Essential Techniques for Imaging Professionals

Richard Harrington 

Peachpit Press  
1249 Eighth Street  
Berkeley, CA 94710  
510/524-2178 

Find us on the Web at: www.peachpit.com 
To report errors, please send a note to errata@peachpit.com

Peachpit Press is a division of Pearson Education

Copyright © 2013 by Richard Harrington, LLC 

Project Editor: Nancy Peterson
Production Editor: Myrna Vladic
Development/Copy Editor: Anne Marie Walker, Robyn G. Thomas
Technical Editor: Wayne Palmer
Compositor: Kim Scott, Bumpy Design
Interior Design: Danielle Foster
Proofreader: Liz Welch
Cover Design: Mimi Heft
Indexer: Jack Lewis
Media Producer: Eric Geoffroy

Notice of Rights
All rights reserved. No part of this book may be reproduced or transmitted in any form by any 
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written 
permission of the publisher. For information on getting permission for reprints and excerpts,  
contact permissions@peachpit.com.

Notice of Liability
The information in this book is distributed on an “As Is” basis without warranty. While every 
precaution has been taken in the preparation of the book, neither the author nor Peachpit shall 
have any liability to any person or entity with respect to any loss or damage caused or alleged to be 
caused directly or indirectly by the instructions contained in this book or by the computer software 
and hardware products described in it.

Trademarks
Adobe and Photoshop are registered trademarks of Adobe Systems Incorporated in the United 
States and/or other countries. All other trademarks are the property of their respective owners. 

Many of the designations used by manufacturers and sellers to distinguish their products are 
claimed as trademarks. Where those designations appear in this book, and Peachpit was aware of 
a trademark claim, the designations appear as requested by the owner of the trademark. All other 
product names and services identified throughout this book are used in editorial fashion only and 
for the benefit of such companies with no intention of infringement of the trademark. No such use, 
or the use of any trade name, is intended to convey endorsement or other affiliation with this book.

ISBN-13: 978-0-321-83462-1

ISBN-10: 	 0-321-83462-3

9 8 7 6 5 4 3 2 1

Printed and bound in the United States of America



Dedication
To my wife Meghan, your patience and support fill my life with meaning.  
Thank you for your love and all that you do.

To my children Michael and Colleen, your curiosity and love inspire me.  
As you grow, you teach me what it means to be a better man.

To my family, thanks for your support and teaching me so much.

Acknowledgments
Several people have played an important role in this book coming to life:

•	 Ron Hansen and Michael Davidson, who gave me my first job teaching  
Adobe Photoshop at the Art Institute of Washington.

•	 Ben Kozuch, who believed in me enough to let me teach Photoshop to a room 
full of media professionals.

•	 Scott Kelby and the other instructors and staff of the National Association of  
Photoshop Professionals for their inspiration and support.

•	 Susan Rimerman and Nancy Peterson for challenging me to write the best  
book possible. Anne Marie Walker and Wayne Palmer for guiding me through 
the process and fixing my flaws.

•	 To James Ball, Jim Tierney, and Abba Shapiro, thank you for your generous  
gift of photos.

•	 To my many students through the years, thanks for the challenges and  
the motivation.

•	 To the staff of RHED Pixel for helping to bring the podcasts to life.



Richard Harrington, PMP
Richard has surrounded himself with media for his entire professional 
career. He’s held such diverse jobs as directing television newscasts and 
publishing a music magazine to managing video production departments 
and consulting to nonprofit agencies. Currently, Richard is a founder of 
RHED Pixel (www.RHEDPixel.com), a visual communications company  
in the Washington, D.C. area.

RHED Pixel is a successful consultancy that provides technical and design 
services to clients such as the Community Health Charities, National Foun-
dation of Credit Counseling, the Smithsonian Institution, Data Robotics, 
and the Children’s National Medical Center. RHED Pixel creates every-
thing from broadcast commercials to live events to interactive projects for a 
diverse clientele.

The Project Management Institute certifies Richard Harrington as a Project 
Management Professional. He holds a master’s degree in project manage-
ment as well. Additionally, Richard is an Adobe Certified Instructor and 
Apple Certified Trainer. He is a member of the National Association of 
Photoshop Professionals Instructor Dream Team.

His personal philosophy is communicate, motivate, create. Richard is a firm 
believer that media can have powerful results. You can follow his evolving 
interests in all things digital at www.RichardHarringtonBlog.com.

Ph
o

to
 b

y 
Sc

o
tt

 K
el

by

www.RHEDPixel.com
www.RichardHarringtonBlog.com


Contents

		  Introduction	 ix
Understanding Adobe Photoshop DVD  

or Downloads	 xi

	 	 Bonus Exercises	 xiii

	 Chapter 1	 Digital Imaging Essentials	 1
Pixels: Digital Building Blocks	 1
Understanding Resolution	 3
Image Mode	 5
Bit Depth	 10
Time to Move On	 10

	 Chapter 2	 Photoshop’s Interface	 11
Understanding the Interface	 12

	 Chapter 3	 Acquiring Digital Images	 25
Digital Cameras	 25
Scanners	 32
Importing from CD/DVD/Blu-ray Disc	 34
Stock Photo Services	 34
Public Domain Images	 35

	 Chapter 4	 Sizing Digital Images	 37
Resolution Revisited	 37
Resampling	 38
Resizing an Image	 40



vi    Contents

	 Chapter 5	 Selection Tools and Techniques	 55
Basic Selection Tools	 56
Additional Selection Commands	 63
Intermediate Selection Techniques	 65
Advanced Selection Techniques	 74
Advice on Selections	 78

	 Chapter 6	 Painting and Drawing Tools	 79
Working with Color	 80
Painting Tools	 85
Eraser Tools	 101
Vector Drawing Tools	 103

	 Chapter 7	 Layer Masking	 107
Layer Mask Essentials	 107
Mask Creation Strategies	 110
Refining Masks	 115
Advice on Masks	 118

	 Chapter 8	 Compositing with Layers	 119
What Are Layers?	 119
Why You Need Layers	 120
Working with Multiple Layers	 126
Creating a Panorama	 132
Auto-Aligning Layers	 134

	 Chapter 9	 Using Blending Modes	 137
About Blending Modes	 137
Blending Modes in Action	 141



Contents    vii

	 Chapter 10	 Color Correction and Enhancement	 145
Approach to Color Correction	 145
Primary Image Adjustments	 147
Useful Image Adjustments	 157
Using Camera Raw 	 165

	 Chapter 11	 Repairing and Improving Photos	 179
Image Selection	 180
The Retoucher’s Toolbox	 181
Restoration in Action	 199

	 Chapter 12	 Using the Type Tool	 209
Role of Type	 210
Choosing Fonts	 210
Using Vector Type	 212
Character Panel	 214
Paragraph Panel	 220
Applying Styles	 222
Modifying Text	 223

	 Chapter 13	 Layer Styles	 227
Adding a Layer Style	 228
Working with Layer Styles	 235

	 Chapter 14	 Maximizing Filters	 239
Filters Defined	 239
Preparing to Use Filters	 240
Understanding Filter Interfaces	 242
Getting the Best Results	 243
The Guide to Standard Filters	 246



viii    Contents

	 Chapter 15	 Actions and Automation	 247
Actions	 247
Automate Commands	 256
Scripts	 263
Automation with Adobe Bridge	 266

	 Chapter 16	 Printing, PDF, and Specialized File Types	 273
Professional Printing Options	 273
Desktop Printing Options	 275
Printing Commands	 276
PDF Essentials	 279
Specialized File Formats	 283
Specialized Processes	 288
End of the Road	 294

		  Index	 295

		

		  DVD Bonus Material	
Chapter 3 Scanner Operation
Chapter 5 Quick Mask Mode
Chapter 6 Creating Spot Color Channels
Chapter 14 The Guide to Standard Filters	



The Role of Photoshop in Education
Learning Adobe Photoshop is essential to success in digital media industries. Photo
shop is a gateway into several related technologies. From digital image acquisition 
and processing to typography and compositing, Photoshop is often your first intro-
duction. If you can master this program, you can go on to success with several other 
technologies. With this in mind, it is important to learn Photoshop with one eye on 
the present and the other on the future.

The Role of Photoshop in Professional Industries
It’s been said that if you know Photoshop, there’s always work to be had. Photoshop 
is used by everyone from photographers to Web developers, video professionals 
to graphic designers. In fact, Photoshop is used in more places than you’d expect—
including the medical, architectural, and legal fields. Adobe Photoshop is a portal 
to Adobe’s other software applications, but it is also much more. Mastering the tools 
in Photoshop will teach you more about creative technology tools than any other 
program. With a solid knowledge of Photoshop, you’ll be well on your way to being 
comfortable with an entire digital toolbox.

Purpose of This Book
When I decided to write this book, it was to fill a need. I have worked with 
Photoshop students of all levels, from the college classroom to working professionals 
across all industries. What I’ve heard time and time again is that people wanted an 
objective book that gave them everything they needed to truly understand Adobe 
Photoshop. Readers have grown tired of books that talk down to them or waste time 
promoting only the latest features.

It’s not that there’s a shortage of good books for the professional; I’ve read many 
of them and know several of their authors. But what has happened over the years, 
as Photoshop has become such an established program, is that we are left with two 
types of books: those for complete beginners and those for pros looking to dig deep 
on specific areas of the program. What was missing? A book that addresses the need 

Introduction
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of the learner who wants to understand the important features of Adobe Photoshop, 
as well as the core technology behind it, to build a solid foundation for future learn-
ing as well as immediate success.

This book is for learners who learn best by not just reading but by doing. Every 
chapter contains extensive hands-on exercises and all the files you need to practice. 
With the purchase of this book you also have immediate access to more than 100 
videos that show you advanced skills and special techniques. In addition, interac-
tive quizzes help you check your progress to ensure that the knowledge is “sticking.” 
The accompanying DVD or digital download has everything you need. And you’ll 
want to be sure to visit www.richardharringtonblog.com for updates and bonus 
downloads.

If you are learning Photoshop in a classroom, this book should combine with your 
instructor’s knowledge to give you a rich, interactive learning experience. For 
those working professionals looking to fill in their understanding of Photoshop, 
this book answers and reinforces the essential information that you’ll need. For 
both audiences, this book teaches you what you need to succeed in the profes-
sional workplace. As a teacher and a working pro, it’s my goal to prepare you for 
professional success.

Suggestions on Learning
Photoshop is a very comprehensive program; don’t try to learn it overnight. In fact, 
rushing to learn is often what causes problems. In an effort to learn quickly, skills 
don’t have time to be absorbed. To combat this problem, I have eliminated nones-
sential topics from this book. I’ve also included a hands-on example or activity for 
every skill.

The truth is you’ll learn best by doing. Don’t skip the hands-on activities in a rush to 
make it through the book. I strongly encourage you to try each one. After complet-
ing the book’s activities, you should repeat the techniques with your own photos. 
Nothing makes a topic as clear as you experiencing it interactively and achieving 
success. With practice—regular and thorough—you can understand and master 
Photoshop.

www.richardharringtonblog.com
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Understanding Adobe Photoshop DVD  
or Downloads
To help you get the most from Adobe Photoshop CS6, I’ve included several  
hands-on and interactive exercises.

Lesson Files
You’ll find more than 250 images as well as 
Photoshop actions on the DVD or in the down-
load to bring the lessons to life. The hands-on 
exercises are meant to be fun and informative, 
so be sure to use the lesson files as part of your 
learning process. 

Interactive Quizzes
To help measure your progress, you’ll find a 
Quizzes folder. Open the file Launch Quizes.
html with a Web browser and take a short quiz 
for each chapter. Just answer ten questions and 
see if you’ve learned the key concepts from each 
chapter. The quizzes use Adobe Flash Player 9 or 
later, so be sure that is loaded on your system. 

Video Training
Throughout the book you’ll see Video Training 
icons that call out more than 100 additional mod-
ules you can watch. But what fun is just watch-
ing? You’ll also find extra images in each lesson’s 
folder to use with the videos.
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Bonus Exercises
We’ve included ten additional Photoshop exer-
cises to hone your skills. These projects include 
all the images you’ll need, along with an outline 
on how to approach the project. These self-paced 
exercises help you refine your skills and gain 
important practice. 

Resource Blog
The author maintains a resource blog at  
www.richardharringtonblog.com. Here you’ll 
find news about graphics technology, tutori-
als, bonus videos, and great resources like free 
images. You can subscribe to the blog for free 
with an RSS reader or by email for notification  
of all posts.

www.richardharringtonblog.com


Color Correction 
and Enhancement10
The primary purpose of 
Photoshop is to act as a digital 
darkroom where images can 
be corrected, enhanced, and 
refined. How do you know an 
image needs touch-up? You 
can pretty much assume every 
image can look a little (or even 
a lot) better than how the cam-
era captured it. Whether it’s 
adjusting the exposure, increas-
ing contrast, or boosting satura-
tion, Photoshop is the place to 
improve an image.

Learning how to spot problems 
and then choosing the right cor-
rection technique is an essential 
part of mastering Photoshop. 
Several different tools are available, some more useful than others. 
By analyzing the most important tools and determining in which 
situations they might help you, you can achieve a more thorough 
understanding of color correction.

Approach to Color Correction
New users often have a difficult time when color correcting or 
enhancing images. They generally lose sight of the goal: making the 
image look better while still being believable. Many users go “too 
far” in their quest to fix images. If the image starts to look fake or 
too altered, it will be distracting. Although getting it “right” requires 
some practice, here’s some general advice to get you started:

The left image is as shot by the camera. The right image has been refined using 
the Camera Raw plugin. You can open the Ch10_Major_Fix.NEF file to experiment.
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•	 Identify what’s wrong. Before you can fix a picture, be sure 
you have decided on what’s wrong. Is it too dark? Is the sky 
washed out? Has the picture faded over time? Make a list and 
prioritize the issues you find in each image. It’s easiest to fix 
one problem at a time, and if you identify those problems, 
you’ll know when to stop twiddling with the image.

•	 Work with a copy of the image. Before you start to color 
correct an image, you should duplicate it. This way you can 
return to an original version if you make a mistake or go too 
far in your image touch-up. After opening your file, choose 
File > Save As and name the duplicate version that will be 
corrected. Color correction can be a destructive process, mean-
ing that you cannot revert to the original state at a later time. 
By preserving an original version of the image or employing 
adjustment layers, you make nondestructive editing possible. 
Some users also choose to duplicate the Background layer at the 
bottom of the layer stack.

•	 Edit with adjustment layers. Adjustment layers allow you to 
apply most of the image correction commands as nondestruc-
tive effects. They are added as a layer above the actual image; 
the adjustment layer can be blended, masked, or deleted at 
any time. Additionally, if you select the adjustment layer, you 
can modify its properties in the Adjustments panel. The same 
modifications are available in both the Adjustments menu and 
Adjustments panel. You should work with an adjustment layer 
whenever possible because its flexibility will be important for 
future revisions.

•	 Get a fresh opinion. It’s not a bad idea to step back and 
examine your work. Open the backup copy of the original 
image and compare it to the image you’ve been working on. 
This before-and-after comparison can be very useful. If you 
have a fresh set of eyes nearby, ask that person for his or her 
opinion.

•	 Use Smart Filters. This will open up most of the filters and 
several of the image adjustments including the Shadows/
Highlights command and Variations. Just choose Filter > 
Convert for Smart Filters.
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Primary Image Adjustments
Photoshop offers several image adjustments, but only a few are 
used most often. Commands such as Levels and Curves are used 
by professionals to achieve outstanding results. These professional 
imaging techniques may take a little time to get comfortable with, 
but the power they offer is worth your investment.

Levels
The Levels command corrects tonal ranges and color balance 
issues. With this command you can fix poor exposure. Addition-
ally, you can perform color correction by manually identifying a 
white point and black point in the image. Nearly every image can 
benefit from making a Levels adjustment.

To understand Levels, you must be able to read a 
histogram. This graph works as a visual guide for 
adjusting the image. The Levels adjustment has 
its own histogram that is visible when working in 
the Adjustments panel. You may also want to call 
up the Histogram panel (Window > Histogram) 
and leave it open while color correcting to help 
you spot issues in color and contrast. You can 
also expand the Histogram panel by clicking the 
submenu and choosing All Channels View. Let’s 
give the command a try.

1.	 Close any open files, and then open the file Ch10_Levels.tif 
from the Chapter 10 folder.

2.	 Add a Levels adjustment layer by clicking the Levels icon in 
the Adjustments panel. Levels is also available from the Adjust-
ments menu (Image > Adjustments), but the adjustment layer is 
more flexible for future modifications.

3.	 This photo was shot under mixed light, but you can reset the 
black and white points of the image to fix the exposure. In the 
Adjustments panel, move the white Input Levels slider to the 
left. This affects the image’s white point and allows you to reas-
sign where white should begin in the image.

Note
Levels Beats  
Brightness/Contrast
A Brightness/Contrast command 
does exist, but the Levels adjust-
ment lets you perform several 
improvements with one com-
mand. Using a single image process 
cuts down on the loss of quality 
introduced from multiple image-
processing steps.
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4.	 Move the black Input Levels slider slowly to the right. The 
more you move the black slider to the right, the more contrast 
is introduced into the image.

5.	 The true power lies in the middle (gray) Input Levels slider. By 
moving this slider, you can modify the gamma setting. Effec-
tively, you can use the middle Input Levels slider to change the 
intensity of the midtones. This adjustment can be made with-
out making dramatic changes to the highlights and shadows, 
and lets you better expose an image. Move the slider to the left 
to add light; move the slider to the right to subtract light.

6.	 In the future if you need to edit the adjustment, simply select 
the adjustment layer in the Layers panel and manipulate the 
controls in the Adjustments panel.

Tip
Rinse and Repeat
If you have several images from the same camera or shoot, they may need 
the same Levels adjustment. The Save button allows you to save a Levels 
adjustment (to the folder that contains the image is a good place). You can 
then click the Load button to apply that adjustment to another image.

Video 61:
Levels Command
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Auto-Levels
When working with the Levels adjustment layer, you may have 
noticed the Auto button. This command button triggers an 
analysis of the histogram data by Photoshop that is then used to 
modify the individual controls of the Levels adjustment. In many 
cases this results in an image that is properly adjusted for color 
balance and exposure issues. In others it will get you closer to a 
corrected image.

1.	 Close any open files, and then Open the file Ch10_Auto_ 
Levels1.tif from the Chapter 10 folder.

2.	 Add a Levels adjustment layer by clicking the Levels icon in 
the Adjustments panel.

3.	 Click the Auto button to 
perform an automated 
adjustment for the image. 
The image’s levels and color 
are adjusted.

4.	 To refine how the automatic 
adjustment works, hold 
down the Option (Alt) key 
and click the Auto button 
again. A new dialog box 
opens.

5.	 Select Enhance Per Chan-
nel Contrast and Snap 
Neutral Midtones to create 
a very natural balance of 
colors for the image.

6.	 Click OK to close the 
dialog box.

7.	 Adjust the middle slider 
(gray) to refine the Levels 
adjustment to taste.
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Color cast
In the first Levels example you made a Levels adjustment to all the 
channels evenly. In the Auto-Levels example, you let Photoshop 
adjust the levels and remove color cast using an automated algo-
rithm. The Levels command can be further isolated to a specific 
channel by clicking the drop-down list in the center of the Levels 
dialog box. This allows you to tackle color cast issues, such as spill 
from a background, a bad white balance, or a photo shot under 
mixed or colored lighting.
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1.	 Close any open files, and then open the file 
Ch10_Levels_Color_Balance.tif from the 
Chapter 10 folder. Notice how the image has 
a greenish tint.

2.	 Add a Levels adjustment layer using the 
Adjustments panel. You will use the Levels 
command to fix color and exposure issues.

3.	 Select the Set White Point (white eyedrop-
per) in the Levels dialog box. Click an area 
that should be pure white. For this image, 
click a bright area in the white pillar. If you 

click an area that is not bright 
enough, the whites in the image 
will overexpose. (You can click 
the Reset button—it looks like a 
circular arrow—at the bottom of 
the Adjustments panel to reset 
the Levels command, if needed.) 
After you click, you’ll see that 
some of the color spill has been 
removed.

4.	 Select the Set Black Point (black eyedropper) 
in the Levels dialog box. Click an area that 
should be pure black. Choose an area such as 
a jacket or a dark shadow. This will adjust the 
color balance and the exposure.

5.	 The image’s color balance should now be bet-
ter. Adjust the middle Input Levels slider to 
brighten the image.

Video 62:
Correcting Color Cast 
with Levels

Video 63:
Adjusting Levels  
per Channel
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Curves
Most users will either use Curves a lot or they won’t use it at all. 
The Curves interface is more complex than Levels, which scares 
away many users. Although Levels gives you three control points 
(highlights, midtones, and shadows), the Curves adjustment allows 
for up to 16 control points. This can significantly open up more 
options when adjusting color and exposure.

Let’s try the Curves command on a practice image.

1.	 Close any open files, and 
then open the file Ch10_
Curves_Practice.tif from 
the Chapter 10 folder.

2.	 Add a Curves adjustment 
layer by clicking the Curves 
button in the Adjustments 
panel. When you first open 
the Curves interface, there 
are two points (one for 
white and one for black).

3.	 Add a single control point 
in the middle of the line 
(click at an Input Value 
of 50%). 

4.	 Pull this new control point 
down to lighten the image 
(toward the lighter area on 
the Y axis). You can pull 
the point up to darken the 
image. Notice that the Input 
and Output values update 
as you drag.

5.	 The adjustment is applied gradually throughout the entire 
image. Multiple points can be employed for contrast adjust-
ments based on tonal range. 

The primary advantage of Curves is that you have precise control 
over which points get mapped (whereas in Levels you do not). 
Another benefit is that Curves adjustments can use several points 

Video 64:
Working with Curves



152    Chapter 10  Color Correction and Enhancement

connected by a curved line (as opposed to Levels, which uses only 
three control points) to make adjustments. So, color correction can 
be applied in a more gradual manner (without the hard clipping 
that can be associated with Levels).

1.	 Close any open files, and then open the image Ch10_Curves.tif 
from the Chapter 10 folder.

Note
Pay Attention to Your Axes
When working with a grayscale or CMYK file, the axes go from light to dark. 
When working with RGB images, the scales are reversed. This means that 
pulling a control point up or down may have a different effect.

Note
RGB Reverse
You’re about to work with an RGB 
image; the direction of darks and 
lights will be reversed from the 
Grayscale image.

2.	 Add a Curves adjustment layer by 
clicking the Curves icon in the Adjust-
ments panel. The curve has only two 
points on it—one representing the 
black point; the other, the white point.

3.	 It’s now time to add more control 
points to refine the curve. To do this, 
you’ll use a Curves preset. Click the 
menu to select a Curves preset in the 
Adjustments panel. Choose the Strong 
Contrast (RGB) preset. Notice that 
the image now has more contrast in 
the shadows and highlights, and more 
visual “pop.”

4.	 Experiment by adjusting the five con-
trol points. Try to further emphasize 
the shadows in the image. Continue 
to experiment by moving the control 
points (you can use the up and down 
arrow keys for precise control).

Tip
Easy Curves
When the Curves Editor is open, you can easily 
add control points. Click the icon that looks like 
a pointing finger, and then just click and drag 
in the image to modify the curve. The control 
points will appear in the editor. 
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Hue/Saturation
The Hue/Saturation command lets you adjust the hue, saturation, 
and lightness of color components in an image. Additionally, you 
can simultaneously adjust all the colors in an image. This com-
mand can work in two ways:

•	 To adjust colors in an image that appears slightly out of phase 
or skewed toward a color, such as an image that appears to 
have a blue overcast

•	 To create stylistic changes by dramatically changing colors in 
an object, such as trying out different combinations of colors 
in a logo

When combined with a selection command (such as Color Range), 
the Hue/Saturation command can be used to selectively enhance 
colors in an image.

Let’s give the command a try.

1.	 Close any open files, and then open the file 
Ch10_Hue_Saturation.tif from the Chapter 
10 folder. You’ll subtly tweak the color in the 
motorcycle.

2.	 Choose Select > Color Range and click the 
motorcycle body to make an initial selection. 
Hold down the Shift key to add to the selec-
tion. Adjust the Fuzziness slider to soften the 
selection. Use the Localized Color Clusters 
to further constrain the selection. Click OK 
when you have a suitable selection.

3.	 Click the Hue/Saturation button in the 
Adjustments panel to add an adjustment 
layer.

Tip
The Five Most Useful 
Image Adjustments

•	 Levels

•	 Curves

•	 Black & White

•	 Vibrance

•	 Shadow/Highlights
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4.	 The two color bars at the bottom of the dialog box represent 
the colors in the color wheel. The upper bar shows the initial 
color; the lower bar shows the new color. Drag the Hue slider 
to the left until maroon appears under red.

5.	 Additionally, you can adjust Saturation (which is the intensity 
of the color) and adjust Lightness (which adds white or black to 
the image). Increase Saturation to +15 and decrease Lightness 
to –20.

Recolor
A Hue/Saturation adjustment can be a fast way to experiment 
with color options. You can use it to quickly change the fill colors 
of an object by making a global adjustment. This works well when 
you are experimenting with different color combinations. Let’s try 
it out.

1.	� Close any open files, and then open the file 
Ch10_Logo_ Adjustments.psd from the 
Chapter 10 folder.

2.	� Select the layer thumbnail of the Hue/Satura-
tion adjustment layer to access its controls in 
the Adjustments panel.

3.	� Adjust the Hue slider to try out different color 
combinations.

Note
A Better Saturation
If you need a more robust satura-
tion control, be sure to try out the 
Vibrance adjustment. It offers its 
own saturation control that uses a 
different method to control satura-
tion. It tends to produce better 
changes, but doesn’t offer Hue or 
Lightness controls.
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Tinting a photo
You can also use the Hue/Saturation command to tint an image.  
If you are working with a grayscale image, you need to convert it 
to an RGB image first.

1.	 Close any open files, and then open the file Ch10_Tint.tif from 
the Chapter 10 folder.

2.	 Add a Hue/Saturation 
adjustment layer.

3.	 Click the Colorize box to 
tint the image.

4.	 Adjust the Hue slider to try 
out different color combina-
tions. Adjust Saturation and 
Lightness to refine the tint.

The adjustment layer auto-
matically has a Layer Mask 
attached, which allows you 
to mask the effect.

5.	 Click the Layer Mask icon 
for the Hue/Saturation 
adjustment layer.

6.	 Select your Brush tool and 
press D to load the default 
colors of black and white.

7.	 With a small black brush, 
paint the flowers so the 
original red shows through. 
If you make a mistake, you 
can press X to toggle back 
to white for touch-up.

Video 65:
Tinting a Photo
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Vibrance
When working with photos, many choose to have very saturated 
and rich colors. The problem with too much saturation is that it 
can cause clipping (a flattening of the range of colors). To help 

with this, Photoshop offers the Vibrance com-
mand. Unlike Saturation, Vibrance only boosts 
those parts of a photo that are less saturated. It 
also respects skin tones, which means photos 
look more natural when pumping up the inten-
sity of color. 

1.	� From the Chapter 10 folder, open the image 
Ch10_Vibrance1.tif.

2.	� You’ll first add a Saturation adjustment layer 
for comparison. In the Adjustments panel, 
click Saturation icon to add a new adjustment 
layer.

3.	� Drag the Saturation slider to the right until 
the colors in the image start to clip. 

4.	� Discard the Saturation adjustment layer by 
clicking the trash icon at the bottom of the 
Adjustments panel. Click Yes in the dialog 
box that appears.

5.	� In the Adjustments panel, click the Vibrance 
icon to add a new adjustment layer.

	

6.	� Drag the Vibrance slider to the right to 
increase saturation without color clipping.

7.	� To add a little more saturation overall (in a 
gentler fashion than the Saturation adjust-
ment layer), use the Saturation slider in the 
Vibrance adjustment layer.

Original image.

Hue/Saturation begins to posterize the reddish areas of 
the image.

A Vibrance adjustment increased saturation selectively.

video 66:
Vibrance
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Useful Image Adjustments
Although a Levels or Curves command can usually get the color-
correction job done, there are often atypical problems that require 
particular commands. Let’s explore some other commands that have 
special purposes and should generally be reserved for the unique 
problems they address. Let’s take a look at the specialty commands.

Black & White
If you want to create a dramatic grayscale or duotone effect, the 
most effective way is to use a Black & White adjustment layer. 
Unlike a simple saturation adjustment, you maintain full control 
over how individual colors are converted. This allows you to 
emphasize or deemphasize specific colors and tonal ranges. Addi-
tionally, you can tint the grayscale by applying a color tone to the 
image (such as a sepia tone).

1.	 Close any open files, and then open the file 
Ch10_Black White Conversion.tif from the 
Chapter 10 folder. 

2.	 Click the Black & White icon in the Adjust-
ments panel.

3.	 Photoshop performs a default grayscale con-
version. You’ll want to adjust the conversion 
using the color sliders. You can also apply an 
Auto conversion or use a saved custom mix.

You can adjust the color sliders to emphasize 
gray tones of specific colors in an image. Each image is unique, 
so you’ll need to find the right balance. Drag a slider to the left 
to darken or to the right to lighten. Be sure to select the Pre-
view check box so you can see the results of your changes.

Tip
Black & White Auto—A Good Start
Normally, I recommend avoiding the Auto buttons, but with the Black & 
White adjustment layer it works well. Auto sets a grayscale mix based on 
the image’s color values. It attempts to maximize the distribution of gray 
values. The Auto mix often produces excellent results and can serve as the 
starting point for tweaking gray values using the color sliders.

Video 67:
Black and White 
Adjustments
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4.	 With the Black & White 
command window open, 
click the icon in the Adjust-
ments panel that looks like 
a pointing finger.

5.	 You can click on the image 
to sample a target. The 
mouse pointer changes to 
an eyedropper if you move 
it over the image. Just click 
and hold on an image area 
to target the right color 
slider for the strongest color 
at that location. You can 
then drag to shift the color 
slider for that color, thus 
making it lighter or darker. 

6.	� To create a duotone effect, 
select the Tint option. To 
change the tint color, click 
its swatch and use the Color 
Picker to choose a new color 
that matches your needs.

Tip
Blended Black and White
Be sure to try out blending modes 
with your adjustment layers. The 
Black & White adjustments look 
great blended. Try Multiply or Over-
lay for this exercise.

Gradient Map
You can use the Gradient Map to dramatically or subtly stylize 
images. The effect works best when used as an adjustment layer. 
The command works by mapping the colors of a gradient to the 
image based on the luminance values of the source image. Let’s 
give the technique a try.

1.	 Close any open files, and then open the image Ch10_
Gradient_Map1.tif from the Chapter 10 folder.

2.	 Click the Gradient Map icon in the Adjustments panel.

Video 68:
Creative Sepia Tones
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3.	 In the Properties panel, click the gradient to 
open the Gradient Editor.

4.	 In the Gradient Editor, choose a loaded gradi-
ent or load a new set to taste. For more on gra-
dients, see Chapter 6, “Painting and Drawing 
Tools.” Click OK when you’re satisfied.

5.	 To soften the effect, you can change the 
adjustment layer’s blending mode. Setting  
it to Hue or Color creates a nice tint effect.

Photo Filter
Professional photographers often place glass filters in front of the 
camera lens. These can be used to “cool” or “warm” a picture, or 
to add special effects. Since Photoshop often tries to simulate or 
correct for steps not taken in the field, the addition of Photo Filters 
was a logical evolution for Photoshop.

Adobe added to the “real-time,” color-correction options with the 
addition of 20 different adjustments. These layers simulate the tra-
ditional colored glass filters. Besides the built-in presets, you can 
also choose custom colors from the Photo Filter interface using the 
standard Color Picker.

There are three main groupings for color effects:

•	 Warming Filter (85 and LBA) and Cooling Filter (80 and 
LBB). These adjustment layers are meant to even out photos 
that were not properly white balanced. The Cooling Filter (80 
or LBB) makes images bluer to simulate cooler ambient light. 
The Warming Filter (85 or LBA) makes images warmer to 
simulate hotter ambient light.

•	 Warming Filter (81) and Cooling Filter (82). These adjust-
ment layers are similar to the previous filters but cast a more 
pronounced color. The Warming Filter (81) makes the photo 
more yellow, and the Cooling Filter (82) makes the photo 
bluer.

•	 Individual Colors. The Photo Filter also has 14 preset colors 
to choose from. These can be used for two primary purposes: 
to add a complementary color to a scene to remove color cast 
or for stylistic reasons.

Video 69:
Stealing Sunsets
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Let’s try applying a Photo Filter adjustment layer.

1.	� Close any open files, and then open the file 
Ch10_Photo_Filter.tif from the Chapter 10 
folder.

2.	� Click the Photo Filter icon in the Adjustments 
panel.

	

3.	� In the Filter area, choose Warming Filter (85) 
to adjust the temperature of the photo. 

4.	� Deselect the Preserve Luminosity option to 
allow the image to darken.

5.	 Adjust the slider to taste.

	� The sky and the image should be “warmer.” 
You can adjust the Density slider to control 
the intensity of the effect.

Shadows/Highlights
Exposure problems often plague photos. Dark shadows may make 
a photo seem unusable, but Photoshop offers a powerful com-
mand for fixing these problems. The image command Shadows/
Highlights is very flexible for solving problems. The command can 
help salvage images where the subject is silhouetted from strong 
backlight. You can also use the command to improve subjects who 
have been washed out by the camera’s flash. 

The Shadows/Highlights command does more than lighten or 
darken an image. It makes adjustments by analyzing neighbor-
ing pixels. However, when first opened, the tool is very basic. It is 
important to select the Show More Options check box, which adds 
significant control. Let’s give the command a try.

1.	 Close any open files, and then open the file Ch10_Shadows_
Highlight_1.tif from the Chapter 10 folder.
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The Shadow/Highlights command is not available as an 
adjustment layer. You can still apply it in a nondestructive 
manner by first converting the photo to a Smart Object.

2.	 Choose Layer > Smart Objects > Convert to Smart Object.

3.	 Choose Image > Adjustments > Shadows/Highlights. The 
image is brightened automatically because the command 
boosts the shadowed areas by default.

4.	 Select the Show More Options check box and be sure to select 
the Preview check box.

5.	 Adjust the Shadows and Highlights of the image: 

•	 Amount. This value determines how strong of an adjust-
ment is made to the image.

•	 Tonal Width. Small values affect a reduced region; larger 
values include the midtones. If pushed too high, halos 
appear around the edges of the image.

•	 Radius. Is a tolerance setting that examines neighboring 
pixels to determine the affected area.

6.	 Modify the image adjustments to improve image quality:

•	 Color Correction. This slider modifies the saturation 
of the adjusted areas. Essentially, it can counterbalance 
washed-out images.

•	 Brightness. If you’re working on a grayscale image, Color 
Correction is replaced by a Brightness control.

•	 Midtone Contrast. This adjustment affects the contrast in 
the midtones of a photo. Positive values increase contrast, 
whereas negative values reduce contrast.

•	 Black Clip and White Clip. This adjustment modifies 
the black point of shadows and lowers the white point of 
highlights. This can lower the intensity of the effect. 

7.	 Click Save if you’d like to store the adjustment to use on 
another photo. When you’re satisfied, click OK to apply 
the adjustment.

If you’d like extra practice, you’ll find additional images in the 
Chapter 10 Extras folder.

Video 70:
Shadows/Highlights
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Exposure
Starting with Photoshop CS2, support was added for 32-bit 
images. Generally referred to as high dynamic range (HDR), these 
images offer great flexibility in exposure. These images can better 
handle re-creating the wide range of exposures found in outdoor 
scenes or intense lighting conditions. The Exposure adjustment is 
usually used on images that exist in 32-bit space and is said to be  
a 32-bit floating point operation (often shortened to float).

Creating an HDR image is a combination of shooting techniques 
and a Photoshop command. It requires that the camera be secured 
firmly to a tripod and that you be careful when triggering or 
adjusting the camera to not move it (or allow anything to move in 
the shot either). Several photos at various exposures are taken of 
the same scene (a minimum of three; usually five to seven is ade-
quate). The camera should have its auto-bracket and ISO features 
disabled. Each shot should be about two f-stops apart. The user 
then harnesses the Merge to HDR command (File > Automate > 
Merge to HDR) to create the 32-bit image. You’ll create an HDR 
image later in the book, but for now let’s jump ahead to an HDR 
image that’s already built. 

1.	� Close any open files, and 
then open the file Ch10_
HDR1.tif. If you click in 
your menus, you’ll notice 
that several features are 
grayed out. Most image 
adjustments do not work for 
a 32-bit image. This image 
was taken in a very low-
light environment, but by 
combining multiple expo-
sures together into the HDR 
image, I captured a much 
better photo.

2.	 Click the Exposure icon in the Adjustments panel. This com-
mand makes tonal adjustments by performing calculations in 
a linear color space (Gamma 1.0) rather than the current color 
space. This offers extreme flexibility for future changes.
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3.	 Three properties can be modified:

•	 Exposure. Modifies the highlight end of the tonal range 
with little effect on the extreme shadows.

•	 Offset. Darkens the shadows and midtones with little effect 
on highlights.

•	 Gamma. Adjusts the gamma of the photo. 

4.	 Additionally, three eyedroppers adjust the image’s luminance 
values:

•	 Set Black Point eyedropper. Sets the Offset, which shifts 
the selected pixel to zero.

•	 Set White Point eyedropper. Sets the Exposure, which 
shifts the selected pixel to white (1.0 for HDR images).

•	 Midtone eyedropper. Sets the Exposure, which shifts the 
selected pixel to the middle gray.

5.	 Make a dramatic adjust-
ment and click OK. Let the 
image blow out, because 
this will show you the flex-
ibility of HDR images.

6.	 Apply a second Exposure 
adjustment and bring the 
image back into a more 
accurate exposure. Notice 
that the blown-out areas 
are restored (this is often 
impossible with 8- or 16-bit 
images captured in a single 
exposure because over
exposed or underexposed 
data is discarded).

Video 71:
Merge to High Dynamic 
Range Pro
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Equalize
The Equalize command can restore contrast to a washed-out 
photo. The command attempts to redistribute pixels so that they 
are equally balanced across the entire range of brightness values. 
The command works best when you sample a small area that will 
drive the overall adjustment. The Equalize command takes the 

lightest area and remaps it to 
pure white, and takes the dark-
est area and remaps it to pure 
black. Let’s give it a try.

1.	� Close any open files, and 
then open the file Ch10_
Equalize1.tif from the  
Chapter 10 folder.

2.	� With the Rectangular 
Marquee tool, make a  
selection inside the largest 
cactus branch.

3.	� Choose Image > Adjust-
ments > Equalize to repair 
the image.

4.	� Make sure the Equalize entire image based on selected area 
check box is selected, and then click OK.

5.	 If the image appears overexposed, you can choose Edit > Fade 
to reduce the intensity of the Equalize command. 

Color Lookup
A new option for color grading in Photoshop CS6 is the ability to 
apply a Color Lookup adjustment layer. The adjustment lets you 
choose from several different included presets (organized into 
three categories: 3DLUT File, Abstract, and Device Link). Each 
method uses a LUT (or lookup table). The benefits of using a LUT 
are that color changes are absolute and work well across multiple 
images for consistent adjustments.

Note
What’s a LUT?
Historically, LUTs have been used 
by the digital cinema industry to 
apply color adjustments between 
different applications. They work by 
building a new table of colors that 
completely remap the colors in use.

Note
Create Your Own LUTs?
In Photoshop CS6, LUTs are meant 
to be applied, not created. You 
can use an application like Adobe 
SpeedGrade to make custom LUTs 
or download them from many 
websites.

Video 72:
Equalize
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1.	 Close any open files, and then open the Ch10_LUT.tif file from 
the Chapter 10 folder.

This image already has a few LUTs applied so you can see the 
results of the adjustments.

2.	 Click the visibility icon next to each LUT adjustment layer. 
Have only one turned on at a time for the best results.

3.	 To apply a new LUT, click the Color Lookup icon in the 
Adjustments panel. 

4.	 In the Properties panel, choose a loaded preset from one of the 
three pop-up menus.

5.	 Modify the adjustment layer to taste and experiment with 
opacity and blending modes.

Tip
Tweak a LUT
Remember that you can adjust the opacity and blending mode for a LUT 
adjustment layer. This leads to several choices when designing.

Using Camera Raw 
The Camera Raw support in Photoshop is enabled by a plug-
in (essentially an application that runs inside Photoshop). With 
Camera Raw you can import and develop raw files, and then pass 
them on to Adobe Photoshop. Camera Raw is designed to work 
with the native files recorded by many cameras. 

A Camera Raw file contains unprocessed and uncompressed data, 
as captured by the digital camera’s image sensor. These native files 
contain much more color and exposure information than a JPEG 
or TIFF file. The camera also includes metadata, such as white 
balance, exposure, and more, specifying how that information 
should be treated.

Video 73:
Recovering a Raw File
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Opening a Raw File
To process a raw file, you’ll need to open it with Photoshop Cam-
era Raw. Essentially, you need to develop the file, deciding during 
the editing stages which information to include. The Camera Raw 
software interprets the metadata and raw file information to gener-
ate a new image.

The good news is that adjustments you make to a raw file are all 
stored as metadata. The adjustments essentially reprocess the raw 
file data. The Camera Raw plug-in writes to a sidecar file, which 
contains instructions on how to treat the raw data. In fact, you can 
have multiple sidecar settings for each raw image.

Let’s try opening a file.

1.	 Close any open files, and then choose File > Open. 

2.	 Navigate to the Chapter 10 folder and select Ch10_Mountain.
NEF. Do not open the file yet.

You can choose more than one file at a time to process with the 
Camera Raw dialog box.

Note
What’s the raw extension?
Raw files are not really a file type 
but rather a description for several 
manufacturer-specific file formats. 
You’ll find several different file  
formats in use, and they will vary  
by camera manufacturer.

Note
Can I Use Camera Raw?
Not all cameras work with Photo-
shop Camera Raw (although the list 
is very long). Adobe keeps updating 
the plug-in to support new cameras 
all the time. To keep track of Cam-
era Raw and for a list of supported 
cameras, visit www.adobe.com/go/
learn_ps_cameraraw.

3.	 Hold down the Command (Ctrl) key and select the  
Ch10_Recover_Raw.NEF file.

4.	 Click the Open button to open both images into the Camera 
Raw window.

Now that you have something to look at, let’s take a quick look 
at the dialog box and its controls.

www.adobe.com/go/learn_ps_cameraraw
www.adobe.com/go/learn_ps_cameraraw


Using Camera Raw     167

An Overview of the Camera Raw Dialog Box 
At first glance, the Camera Raw dialog box can be a little over-
whelming. It’s okay to feel this way, because there truly are a lot of 
sliders and tabs. What you’ll find, however, is that the controls are 
fairly intuitive and very powerful. Here’s a quick overview of what 
you’ll find:

A	� Filmstrip. If you select more than a single image to open, the 
images will display here. It is possible to apply star rankings to 
images in the Filmstrip. You can also synchronize the settings 
between multiple clips. Just adjust one image, select similar 
images, and then click the Synchronize button.

B	 �Toggle Filmstrip. If you don’t want to see the Filmstrip, just 
double-click the bar. You can also drag to resize the preview 
thumbnails.

C	� Camera name or file format. The camera name and model 
appears at the top of the window so you know more about 
the file.

Tip
Clipped Warnings
As you make adjustments to the 
developed image, it’s possible 
to clip data (essentially a loss of 
detail). In the Histogram display, 
you’ll see two small triangles. You 
can click the one on the left for 
shadows and the one on the right 
for highlights. When enabled, 
clipped shadows appear in blue, and 
clipped highlights appear in red. 
Highlight clipping will warn you if 
any one of the three RGB channels 
is clipped (fully saturated with no 
detail). Shadow clipping will warn 
you if all three RGB channels are 
clipped (black with no detail).

A C D E F G
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D	� Toggle full-screen mode. It is possible to maximize the 
Camera Raw window to see more details and a larger interface. 
Click to toggle between the larger and default view.

E	� Image adjustment tabs. There are ten tabs in total for control-
ling the development of Camera Raw files. More on these in the 
next section.

F	� Histogram. The Histogram displays the tonal range of the 
developing image. The left edge shows the shadows, whereas 
the right shows the highlights.

G	� Camera Raw Settings menu. Click this submenu to access 
controls for saving and loading custom settings.

H	 �Zoom levels. You can adjust the magnification level of the 
image. The most accurate view is 100%, but you’ll likely choose 
to zoom out to see the entire image in full.

I	 �Workflow options. You can specify how images should be 
saved from Camera Raw and how they should be opened in 
Photoshop. Clicking the blue hyperlinked text lets you choose  
a color mode, bit depth, file size, and resolution.

J	� Navigation arrows. Let you switch between multiple images. 
These work well if the Filmstrip is hidden.

K	� Adjustment sliders. For each adjustment tab, you’ll find a set 
of sliders. These controls are essential for developing the image.

Image Adjustments Tabs
The Camera Raw dialog box offers ten tabs to process your raw 
files. The tabs are organized by task. Normally, you’ll use only 
some of the tabs to adjust each image. For learning purposes, let’s 
take a quick look at each.

Basic
The Basic tab lets you make primary adjustments to white bal-
ance, color saturation, and tonality. These are the most important 
controls and the ones you’re most likely to change.

1.	 Click the White Balance list and choose Auto to have Camera 
Raw attempt to automatically adjust white balance.

2.	 Let’s set a different white balance. Select the White Balance 
tool and click on one of the clouds in the sky.

Tip
Go Big
One of the major benefits of 
shooting raw is an increased bit 
depth. Be sure to click the Workflow 
Options link and set Camera Raw to 
develop 16-bit files. In the Work-
flow Options dialog box, you can 
also choose Open in Photoshop as 
Smart Objects.

Video 74:
Working with Shadows 
and Highlights in Raw
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Across the Camera Raw window is its own toolbar. You’ll see several similarities to the 
Photoshop tools you’re already familiar with:

A B C D E H I JF G K L M N

A	 Zoom tool (Z). You can click on an image to zoom into an area. You can also click and 
drag to make a selection for zooming.

B	 Hand tool (H). When zoomed, you can use the Hand tool to pan across an image. Hold 
down the spacebar to temporarily switch to the Hand tool.

C	 White Balance tool (I). You can override the white balance settings written by the 
camera. Just click to select the tool, and then click on an area of the image that should 
be white or gray.

D	 Color Sampler tool (S). You can add up to eight sample points. These are useful ways 
to track changes in color as you make adjustments to an image. Many users will place a 
sampler on a white and black area of an image to track any shifts in color.

E	 Targeted Adjustment tool (T). There are five different tools to choose from. Click and 
hold to select specific tools.

F	 Crop tool (C). You can crop freely or select from several preset aspect ratios. Remember 
that any adjustments you make are nondestructive. The cropping will be applied when 
the image is opened.

G	 Straighten tool (A). If your photo is crooked, just select the Straighten tool. Click and 
drag with the Straighten tool in the preview image to establish a horizontal or vertical 
angle.

H	 Spot Removal tool (B). The Spot Removal tool lets you heal or clone imperfections in 
the raw file. The most typical problem you’ll need to tackle is sensor or lens dust.

I	 Red Eye Removal tool (E). If an image has red eye, select this tool and click on the center 
of the pupil.

J	 Adjustments Brush (K). This powerful tool lets you brush in localized color and expo-
sure adjustments. Click and brush over an area to define it, and then adjust settings with 
the Adjustment sliders.

K	 Graduated Filter (G). This tool is similar to the Adjustments Brush except it allows you 
to create a transitioned adjustment gradually between two points. This is most typically 
used to fix areas like a sky.

L	 Open Preferences dialog box (Command+K or Ctrl+K)

M	 Rotate Image Left (L). Rotates the image 90° counterclockwise.

N	 Rotate Image Right (R). Rotates the image 90° clockwise.

The Raw Toolbar
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3.	 In the Basic controls, click Auto to have Camera Raw analyze 
the image and make adjustments.

4.	 Drag the Exposure slide to +0.35 to brighten the image.

The image is now brighter, but some of the highlights are 
too bright.

5.	 Drag the Highlights slider to –25 to recover detail in the 
brightest areas.

Let’s put a little more color into the image.

6.	 Boost the Saturation to +45 to increase the overall color in 
the shot.

7.	 Let’s bring the color in the sky out a bit more. Increase the 
Vibrance slider to +30 to richen the sky without oversaturating 
the reds in the photo.

Now that color is correct, let’s enhance Contrast. The Clarity 
slider is best for this. To accurately judge clarity, you’ll need to 
change your view.

8.	 Double-click the Zoom tool to switch to 100% magnification.

9.	 Drag the Clarity slider to the right slowly. Stop when you start 
to notice halos near the edge of details.

Around +45 you should notice a blooming effect; at this point 
you have too much clarity.
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10.	Drag the Clarity slider back to the left until the halos disap-
pear. A value of 30 for this image seems to work well.

11.	 Click the Zoom Levels presets list and choose Fit In View.

12.	Toggle the check box for Preview (near the top of the window) 
to see the before and after states. 

13.	Make sure the Preview check box is selected, and then click 
the Tone Curve tab.

Tone Curve 
With the Tone Curve, you can fine-tune tonality in an image with 
controls similar to Photoshop’s Curves adjustment. You can choose 
to use either a Parametric curve or a Point curve.

1.	 In the Tone Curve controls, click the Point tab.

2.	 From the Curve presets list, choose Strong Contrast.

You can also click the curve and make adjustments like the 
Curves adjustment layer that you learned earlier.

3.	 Toggle the check box for Preview (near the top of the window) 
to see the before and after states. 

4.	 Make sure the Preview check box is selected, and then click 
the Detail tab.

Detail
The Detail tab offers precise control over both sharpening an 
image as well as reducing noise. All raw images will need some 
sharpening. Noise, on the other hand, may not appear unless the 
image was shot with a high ISO setting or under low light.

1.	 Double-click the Zoom tool to switch to 100% magnification.

It’s easiest to accurately judge both sharpening and noise at a 
100% view.

2.	 In the Detail tab, you can adjust sharpening to bring out fine 
image details:

•	 Amount. Increases definition at the edges of an image. Use 
a lower amount for a cleaner image. When you open the 
file, the Camera Raw plug-in calculates the settings to use 
based on camera model, ISO, and exposure compensation. 
For this image, enter 35.
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•	 Radius. Use a low number for fine detail and a higher 
number if the photo lacks much detail. For this image use  
a lower number like 1.2 to preserve detail in the rocks. 

•	 Detail. Controls how much high-frequency information is 
sharpened in the image and how the edges are emphasized. 
For this image, try a value of 50 to bring out lots of detail.

•	 Masking. Controls the edge of the mask. Using a value 
of zero means that everything receives the same amount 
of sharpening. A higher number limits the sharpening to 
those areas near the strongest edges.

An easy way to tell how much masking to use is to hold down 
the Option (Alt) key while dragging. White areas will be 
sharpened; black areas are ignored (masked). Try this out: 
Hold down the Option (Alt) key and drag slowly to the right.  
A value of 50 seems to be the right balance for this image.

3.	 Noise reduction controls let you remove extra grain from 
the image:

•	 Luminance. Reduces luminance noise. Set this to 10 for 
this image (it’s not very noisy).

•	 Luminance Detail. Sets a threshold for the noise reduc-
tion. Higher values preserve detail but can produce noisier 
results. Lower values tend to produce cleaner results but 
likely remove some detail. Use a value of 80 to preserve 
more details.
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•	 Luminance Contrast. Works best for very noisy photos.  
A value of 80 works well for this image.

•	 Color. Reduces color noise. The default is fine for this image.

•	 Color Detail. Use a higher value to protect detailed edges. 
A lower value preserves more color but can result in color 
bleeding. The default is fine for this image.

4.	 Toggle the check box for Preview to see the before and after 
states. This image is very subtly changed.

5.	 Click the Zoom Levels presets list and choose Fit In View.

6.	 Make sure the Preview check box is selected, and then click the 
HSL/Grayscale tab.

HSL/Grayscale 
The HSL/Grayscale tab offers fine-tuning controls for Hue, Satura-
tion, and Luminance adjustments. The most typical use of this tab 
is to target a particular color or tone that needs emphasis.

1.	 Select the Saturation tab.

2.	 Drag the Red slider to the left to deemphasize the Red tones. 

Try a value of –10 for this image.

3.	 Drag the Blue slider to the right to boost the sky further. 

Try a value of +25 for this image.

The image on the top is prior to adjustments. On the bottom, 
the increased saturation comes through.

Before

After
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4.	 Switch to the Luminance tab to change the brightness of a 
color range.

5.	 Enter a value of +15 for both the Red and Orange sliders to 
lighten the rocky areas of the mountain.

6.	 Toggle the check box for Preview to see the before and after 
states.

7.	 Make sure the Preview check box is selected, and then click 
the Split Toning tab.

Split Toning 
The Split Toning controls are used when you want to color a gray-
scale image. It only works if you select the Convert To Grayscale 
in the HSL/Grayscale tab or work with a grayscale image.

Click the Lens Corrections tab.

Lens Corrections 
The Lens Corrections tab attempts to compensate for defects in 
lens technology. The first tab lets you automatically compensate 
for any physical distortion based on a lens profile.

1.	 Click the option for the Enable Lens Profile Corrections.

Photoshop automatically removes some of the wide-angle  
distortion from the image. You can refine the adjustment  
using the third tab (Manual).

Video 75:
Lens Correction in Raw
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2.	 At the bottom, you can 
adjust for lens vignetting. 
This lets you compensate 
for shadows caused by the 
lens or hood.

3.	 Click the second tab (Color) 
to adjust for common 
problems like chromatic 
aberration. 

This particular image 
suffers from neither issue. 
Chromatic aberration shows as fringing in the color, particu-
larly at the edges of the image. It is easiest to see aberration at 
100% magnification.

4.	 Click the Effects tab.

Effects
The Effects tab can be used to stylize the image. It is used to add 
photographic imperfections that were more typical with film-based 
cameras. You can choose to simulate film grain or apply a post 
crop vignette to the edges.

1.	 Double-click the Zoom tool to switch to 100% magnification.

It’s easiest to accurately judge grain at a 100% view.

2.	 Set grain to a value of 15 and a size of 35 to create a filmic type 
noise in the image.
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3.	 Click the Zoom Levels presets list and choose Fit In View.

4.	 You can use a post crop vignette to stylize the images edges:

•	 Style. You’ll find three different options for how the 
vignette shades the image. The default, Highlight variety, 
works best for this image.

•	 Amount. Use a negative value to darken the edges or a 
positive to brighten them. For this image, enter –25.

•	 Midpoint. Controls how close the vignette appears to the 
corner of the image. Enter 60 to push out the edges.

•	 Roundness. A positive value creates a circular effect, 
whereas a negative value takes on an oval shape. The 
default is fine for this image.

•	 Feather. Can create a gentler transition between the 
affected areas. The default is fine for this image.

Tip
More Practice
You’ll find additional raw files in the 
Chapter 10 folder to practice with. 
These include overexposed and 
underexposed images as well as 
grainy and noisy images for cleanup.

•	 Highlights. If you’re using a very dark vignette, the High-
lights slider can be used to protect the brightest tones in 
your image.

5.	 Make sure the Preview check box is selected, and then click 
the Camera Calibration tab.
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Camera Calibration 
The Camera Calibration tab is used to apply specific profiles 
to raw images. Typically, you’ll use it to correct for color cast 
(unwanted spill) in an image. It can also compensate for  
unwanted behaviors by a camera’s image sensor.

•	 Process. The process list lets you choose a decode technique. 
The newer 2010 process is a significant improvement that ships 
with Photoshop CS6. If you’re working with raw files you’ve 
processed with an older decoder, be sure to switch and update 
the file for greater control and quality.

•	 Camera Profile. You’ll find three types of camera pro-
files. The ACR options are compatible with older versions 
of Camera Raw. The Adobe Standard option works best for 
Photoshop CS6. You’ll also find profiles that attempt to match 
the manufacturer’s presets for shooting modes like neutral, 
standard, and vivid. In most cases (including this one) Adobe 
Standard is best.

Make sure the Preview check box is selected, and then click 
the Presets tab.

Presets 
If you like a setting you’ve created, you can save it as a preset, 
which makes it easier to reload in the future. Remember that  
custom presets can serve as a great starting point (especially if  
you have several images from the same shoot). To make a preset, 
just click the pad-shaped button at the bottom of the window.

Make sure the Preview check box is selected, and then click the 
Snapshots tab.

Snapshots 
Another way to store a version of your image is to create a snap-
shot. Each snapshot is essentially a recording of the image’s cur-
rent state. You can in fact create multiple snapshots for a raw file 
and easily switch between them.

Tip
Other Than Raw Files?
You can in fact open TIFF and JPEG 
files using the Camera Raw plug-in. 
You need to switch to Adobe Bridge 
and select the desired files. Then 
choose File > Open In Camera Raw. 
You won’t see any major benefits to 
image quality, but you can use the 
Camera Raw dialog box to adjust 
the images.

Video 76:
Removing Noise  
in a Raw File
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Finish the Process
When you are satisfied with the settings you’ve entered into the 
Adjustment sliders, you can decide what to do with the file. Before 
you open (or close) the file, you should check a few things.

1.	 Click the Workflow Options text at the bottom of the image.

2.	 Set the Depth to 16 Bits/Channel for the maximum tonal 
fidelity.

3.	 Set the resolution to 300 pixels per inch.

4.	� Select the Open in Photoshop as Smart 
Objects check box to ensure future ease  
in readjusting the raw processing.

5.	 Click OK to store the settings.

6.	 Select the Straighten tool (A).

7.	� Drag across the horizon line at the base of the 
mountain to straighten the image.

	� When you release, you’ll see a new crop box 
drawn on the image. If you need to reset the 
crop, click the Crop tool in the Tools panel 
and choose Clear Crop.

8.	� You now must choose what to do with the file. 
Clicking the Done button stores the Camera 
Raw settings in a sidecar file (or database) 
without opening the image in Photoshop. For 

this image, click Open Object 
to develop the raw file and send 
it to Photoshop.

A new file opens in Photoshop 
with the raw file added as a 
Smart Object. 

You can now use any of the 
adjustment techniques you’ve 

learned in this chapter. Be sure 
to save the file as a layered 

Photoshop or TIFF file. If you need to reprocess the raw file, just 
double-click its thumbnail in the Layers panel to reopen the image 
into Camera Raw.

The image on the left is unprocessed, whereas the image on the right has had 
many settings adjusted.
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3 by 3 Average method, with Eyedropper Tool, 83
3D text, video, 226
5 by 5 Average method, with Eyedropper Tool, 83
8-bit images, Skin Tones option with, 67
16-bit images, 67, 276
32-bit images, 10, 162–163
64-bit operating system, 23

A
About tab, in Kuler panel, 82
actions

creating, 251–254
features of, 247–248
modifying, 249
saving/sharing, 254
third-party, 250–251
tips for creating, 255

Actions panel, 22, 248–249
Adaptive Wide-Angle Correction plug-in, 197–198
Add to selection option

for Lasso tools, 60
for Magic Wand tool, 62
for Marquee tools, 57

adjusting skin tones, video, 67
adjustment layers, 18, 124
Adjustments panel, 17, 146–148
Adobe Bridge. see Bridge
Adobe Digital Negative (DNG) file format, 30, 287–288
Adobe Lightroom, 30
Adobe PDF standards, 280
Adobe Photoshop DVD/downloads, understanding, xi–xii
Airbrush option, for Brush tool, 93
alerts, Color panel, 84
Alignment buttons, in Paragraph panel, 220
alignment of layers, 127
All command, on Select menu, 63
Allow Tool Recording, in Actions panel, 22
alpha channels, adding, 110, 291–292
Angle Gradient option, 100
Angle Jitter and Control options, in Shape Dynamics  

tab, 89
Angle option, in Brush Tip Shape tab, 87
animated previews, of brush tip shapes, 86
Anti-alias settings

in Character panel, 220
for Elliptical Marquee tool, 58
for Lasso tools, 60
for Magic Wand tool, 62
pros and cons of, 26

Apple Aperture, 30
Application Frame function, 12
Art History Brush tool, 96
ascenders, in font choice, 211
Attribute criteria, in Filter Type menu, 131

Auto-Align Layers command, 134–135
Auto-Enhance option, with Quick Selection tool, 61
Auto-Levels adjustment, for color correction, 149
automate commands

Batch, 256–259
Conditional Mode Change/Fit Image, 260
Crop And Straighten Photos, 259–260
function of, 247
Merge to HDR Pro, 261–262
Photomerge, 261

automation, with Adobe Bridge, 266–272

B
Background Eraser tool, 102
Base color, 138
baseline shift for type, 217
Basic tab, in Camera Raw dialog box, 168, 170–171
Batch command, 256–259
batch renaming files, with Bridge, 266–267
Bayer filters, for digital cameras, 26
Bevel and Emboss effect, 228–230
bevel overuse, 229
bit depth

features of, 10
for filtering, 241
shooting raw and, 29, 168

Bitmap mode, 8
Black & White adjustment, 157–158
Black & White viewing mode, for Refine Edge, 71
Blend color, 138
Blend Images Together option, 133
blending modes

applying images with, 143–144
with Black & White adjustment, 158
design rules for, 141
Fade command accessing, 245–246
keyboard shortcuts for, 144
in layers, 121
list of, 138–140
power/flexibility of, 140–141
for shadowed images, 143
understanding, 137–138
for washed-out images, 142–143

Blu-ray disc, importing from, 34
Blur Focal Distance setting, 205–206
Blur tool, 116–117, 190–191, 243
bonus exercises, xiii–xvi
Border command, 64
Bridge

batch renaming files with, 266–267
importing images with, 31
launch at Login, 267
PDF contact sheets/presentations with, 268–272

Brightness Jitter option, in Color Dynamics, 91
Bristle Tips options, 93
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setting kerning in, 216
setting leading/font size in, 215
text color choice in, 218
as text tool, 23
Type Enhancement buttons in, 218–219
vertical scale/horizontal scale/baseline shift in, 217

Character Styles panel, 222
Check Spelling command, 215
Clean options, for Mixer Brush tool, 94
Clear Override button, in Styles panel, 223
clipped data warnings, 167
Clipping Mask technique, 129–130
clipping paths, creating, 292–293
Clone Stamp tool, 181–182
CMYK Color mode

conversion to, 290–291
for desktop printing, 275–276
for professional printing, 6

Color blending mode, 140
Color Burn blending mode, 139
color cast correction, 150
color correction/enhancement

approach to, 145–146
Auto-Levels adjustment for, 149
Black & White adjustment for, 157–158
of color cast issues, 150
Color Lookup adjustment layer for, 164–165
Curves adjustment for, 151–152
Equalize command for, 164
Exposure adjustment for, 162–163
Gradient Maps for, 158–159
Hue/Saturation adjustment for, 153–154
Levels adjustment for, 147–148
Photo Filters for, 159–160
Shadows/Highlights command for, 160–161
with tinting, 155
Vibrance command for, 156

Color criteria, in Filter Type menu, 131
Color Dodge blending mode, 139
Color Dynamics tabs, in Brush Presets, 91
color gamut, 6, 194
Color Libraries, 80–81
Color Lookup adjustment layer, 164–165
color management, for printing, 278
Color Model setting, in Noise Editor, 99
Color Overlay effect, in Layer Styles, 232
Color panel, 18, 84
Color Picker, 18, 80, 218
Color Range command, 65–68, 112
Color Range sliders, in Noise Editor, 99
Color Replacement tool, 93
color separation, in professional printing, 274
Color stops setting, in Solid Editor, 98
color, working with

Color Libraries, 80–81
Color Picker, 80
Color/Swatches panels, 84

Browse tab, in Kuler panel, 82
Brush Pose option, 92
Brush Preset Picker option, 93
brush presets

accessing, 85–86
options in, 86–91

Brush Tip Shape tab, 86–88
Brush tool options, 93
brushes

additional options for, 92
creating custom, 87
recording strokes, 88

Brushes panel, 85–91, 92
Brushes panel button, 93
Build Up option, 92
Burn tool, for lightening/darkening images, 193

C
Calculations command, 76–78, 113–114
Camera Calibration tab, 177
Camera Raw

Basic tab in, 168, 170–171
Camera Calibration tab in, 177
creating presets/snapshots, 177
Detail tab in, 171–173
developing images with, 30
dialog box overview, 167–168
Effects tab in, 175–176
features of, 165
final steps in, 178
format, 10
HSL/Grayscale tab in, 173–174
interface, video, 29
Lens Corrections tab in, 174–175
opening raw file with, 166
Split Toning controls in, 174
Tone Curve tab in, 171
toolbar, 169

Canvas Size dialog box, 41–42
card-based storage, of pixels, 2
CD (compact disc), importing from, 34
channel(s)

alpha, video, 42
adding alpha, 291–292
creating, 68
spot color, video, 81
understanding, video, 17

Channels panel
creating Layer Masks with, 111–112
features of, 16–17
selection techniques with, 74–75

Character panel
adjusting tracking in, 216–217
Anti-alias settings in, 220
Font Family menu in, 214
Font Style menu in, 214–215
ligatures/language selection in, 219
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desktop printing
paper for, 276
printer categories for, 275
RGB vs. CMYK in, 275–276

Detail tab, in Camera Raw dialog box, 171–173
Detect Faces option, 67
Diamond Gradient option, 100
Difference blending mode, 139
digital cameras

downloading images from, 31
JPEG vs. raw formats for, 27–30
technology of, 25–27

digital imaging
image modes in, 5–9
JPEG format and, 28–29
pixels in, 1–2
resampling and, 38–39
resolution in, 3–5
sizing images. see sizing digital images

Digital Negative (DNG) file format, 30, 287–288
digital video disc (DVD), importing from, 34
Dissolve blending mode, 139
Distort option, in Free Transform command, 49
distortion, Adaptive Wide-Angle Correction for, 197–198
distribution of layers, 127–128
Divide blending mode, 140
docking panels, 19
Dodge tool, lightening/darkening images with, 193
dots per inch (dpi), 3
downloading images, from digital cameras, 31
downsampling, 38
drawing tools, 103–106
Drop Shadow effect, in Layer Styles, 233–234
drum scanners, 33
Dual Brush tab, 90
duotone images, 7, 235
Duplicate Layer option, 124
DVD (digital video disc), importing from, 34
dye sublimation printers, 275

E
Edge Contrast option, for Magnetic Lasso tool, 60
Edge Detection option, for Refine Edge, 72
edges

Bevel and Emboss effect, 228–230
smoothing, filters and, 245

Effect criteria, in Filter Type menu, 130
Effects tab, in Camera Raw dialog box, 175–176
Ellipse tool, 103
Elliptical Marquee tool, 56–58
Encapsulated PostScript (EPS) language file format, 284
Equalize command, 164
Eraser tools, 101–102
Every-line Composer option, in Paragraph panel, 221
Exclusion blending mode, in Paragraph panel, 139
exercises, bonus, xiii–xvi
Expand command, 64

Eyedropper tool, 82–83
Kuler panel, 81–82

compact disc (CD), importing from, 34
composition overlays, in cropping images, 42
compression artifacts

with JPEG format, 27–28
with raw shooting, 29–30

Compression settings, in Save Adobe PDF dialog box, 281
CompuServe GIF file format, 283–284
computer monitors, 3, 4, 6
Conditional Mode Change command, 260
contact sheets, Output Module creating, 268–269
Content-Aware fill option, 188–189
Content-Aware Move tool, 189–190
content-aware patching, video, 187
Content-Aware scaling feature, 51
Contiguous option, for Magic Wand tool, 62
continuous-tone images, 273
Contour setting, in Layer Styles, 229–230
Contract command, 64
Contrast slider, for Refine Edge command, 72
conversion

to CMYK, 290–291
of file formats, 258

Copy Merged command, 131
copyright, fair-use doctrine and, 36
corner pinning images, video, 144
Count Jitter and Control options, in Scattering tab, 90
Count option, in Scattering tab, 90
Create Alpha Channel, 291–292
Create new shapshot button, in History panel, 96
Create tab, in Kuler panel, 82
Crop And Straighten Command, video, 32
Crop And Straighten Photos command, 259–260
Crop tool

disabling motion in, 45
sizing images and, 42–44
Straighten button in, 44

cropping
perspective, 46–47
power, 44–45

Curves adjustment, 151–152, 201
custom brushes, 87
custom gradients, video 42
Custom Shape tool, 104

D
Darken blending mode, 139
Darker color blending mode, 139
Decontaminate Colors option, with Refine Edge 

command, 73
default interpolation method, 39
Delete Cropped Pixels option, 44
Delete Layer option, 124
descenders, in font choice, 211
Deselect command, 63
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G
gamut, defined, 6
gamut warning color, 194
General category, in Preferences, 13
Gradient editor, 97–98
Gradient Layers, 125
Gradient Maps, 102, 158–159
Gradient Overlay effect, 232
Gradient tool, 99–101, 110–111
Gradient Type setting, 98
grain, removing, 204–205
Graphics Interchange Format (GIF), 283–284
grayscale images, 7
grouping layers, 128
Grow command, 64

H
halftones, 5, 274
Hard Light blending mode, 139
Hard Mix blending mode, 139
Hardness option, in Brush Tip Shape tab, 88
HDR (high dynamic range) images, exposure and, 

162–163
Healing Brush tool, 183–184
Histogram panel, 21
historical image repair/restoration, 180, 192, 201, 235
History Brush tool, 95–97
History panel, 22, 96
horizontal scale for type, 217
Horizontal Type tool, 212–213
HSL/Grayscale tab, in Camera Raw, 173–174
Hue blending mode, 140
Hue Jitter option, in Color Dynamics tabs, 91
Hue/Saturation adjustment

color correction with, 153–154
for faded photos, 201
global adjustment with, 154
tinting with, 155

Hyphenate check box, in Paragraph panel, 221

I
image modes

bit depth in, 10
Bitmap/Indexed Color, 8
converting, video, 5
grayscale/duotone, 7
Lab Color/Multichannel, 9
RGB Color/CMYK Color, 6

Image Processor command, 263–264
Image Size dialog box, 40–41
Indent fields, in Paragraph panel, 221
Indexed Color mode, 8
Info panel, 21
inkjet printers, 275
Inner Glow effect, 231
Inner Shadow effect, 230
Input levels slider, in Adjustments panel, 147–148

Exposure adjustment, in HDR images, 162–163
Eyedropper tool, 82–83

F
Fade command, 245–246
Fade option, for Size Jitter and Control, 88
fair-use doctrine, copyright and, 36
Feather command, 64
Feather selection option, 58, 60
Feather slider, for Refine Edge command, 72
file formats

for embedded transparency, 286
specialized, 283–288
for spot color channels, 285

filenaming compatibility, 257
Fill Layers, 125
film scanners, 32
filtering text, 226
filtering view of layers, 130–131
filter(s)

blending modes, video, 127
defined, 239–240
defining target area/smoothing edges, 245
Fade command with, 245–246
graphic cards for, 243
guide, 246
interfaces for, 242
preparing to use, 240–241
Smart Filters, 243–244

Fit Image command, 260
Fixed Ratio Style option, 58
Fixed Size Style option, 58
flatbed scanners, 32
Flatten All Layer Effects, 231
Flatten Image command, 131
flexibility, of fonts, 210
Flip Horizontal/Flip Vertical options, in Free Transform 

command, 50
Flip X option, in Brush Tip Shape tab, 87
Flip Y option, in Brush Tip Shape tab, 87
Flow Jitter and Control options, in Transfer tab, 91
Flow option, for Brush tool, 93
Font Family menu, 214
Font Style menu, 214–215
font(s)

choosing, 210–212
managing, 226
number of, 214
size/websites for, 215
weight/families, 212

Foreground/Background Jitter and Control options, 91
formatting text, video, 213
free images, online sites for, 35
Free Transform command

modifying text with, 223–224
in sizing images, 48–50

Frequency option, for Magnetic Lasso tool, 61
function keys, actions assigned to, 247–248
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deleting, 110
disabling, 109
Properties panel refining, 115–116
with Smart Filters, 244
Smudge/Blur tools refining, 116–117

Layer Styles
applying to text, 225–226
Bevel and Emboss effect in, 228–230
Contour setting in, 229
creating/saving, 237
Drop Shadow effect in, 233–234
Inner Glow/Outer Glow effects in, 231
Pattern Overlay effect in, 233
presets for, 235–236
reordering of, 227
Satin/Color Overlay/Gradient Overlay effects in, 232
shortcuts for, 234
Stroke/Inner Shadow effects in, 230
Styles panel accessing, 19

layer(s). see also specific layers
changing color of, 234
in composite image, 120–123
creating, 123
duplicating/deleting, 124
explained, 119
mobility, keyboard shortcuts for, 123
need for, 120
organization, video, 127
selective warping of, 51–53
understanding, video, 16
working with multiple, 126–131

Layers panel, 16, 137–138
leading value, setting, 215
Lens Blur filter, 205–206
Lens Corrections filter, 195–196
Lens Corrections tab, in Camera Raw, 174–175
Levels adjustment

applied to layers, 122
automated adjustment in, 149
command, video, 148
for color cast issues, 150
for color correction, 147–148
for faded photos, 201

ligatures, in Character panel, 219
Lighten blending mode, 139
Lighter Color blending mode, 139
Line tool, 103
Linear Burn blending mode, 139
Linear Dodge blending mode, 139
Linear Gradient option, 100
Linear Light blending mode, 139
lines per inch (lpi), common settings for, 5
linking layers, 126
locking layers, 128–129
luminance noise, removing, 204–205
Luminosity blending mode, 140
LUTS (lookup tables), for color grading, 164–165

interface, Photoshop
Channels panel, 16–17
for filters, 242
Histogram/Info panels, 21
History/Actions panels, 22
Layers panel, 16
Navigator panel, 19
Options bar, 15
Paragraph/Mini Bridge panels, 24
Paths/Adjustments panels, 17
Properties/Color panels, 18
Swatches/Styles panels, 19
Timeline/Character panels, 23
Tools panel, 12–14
versions of, 12

Internet resources
for fonts, 215
stock photo sites, 35

interpolated resolution vs. optical, 5
interpolation methods, of resampling, 38–39
Intersect with selection option, 57, 60, 62
Inverse command, 64–65

J
JPEG ( Joint Photographic Experts Group) format

Camera Raw with, 29
compressing images with, 27
features of, 285
inferior image quality with, 28–29

Justification buttons, in Paragraph panel, 220

K
kerning adjustments, 216
keyboard shortcuts

for blending modes, 144
for Brushes panel, 92
for layer mobility, 123
for Swatches panel, 84
for Vanishing Point, 208

Kind criteria, in Filter Type menu, 130
Kuler panel, 81–82

L
L*a*b* Color mode, 9
language selection, in Character panel, 219
Large Document Format (PSB), 285–286
laser printers, 275
Lasso tools, 59–61
Layer Comps, 136, 265
Layer Mask option, with Refine Edge command, 73
Layer Masks

adding, 108–109
adjusting content in, 117–118
advice on, 118
blending photos, 134
Calculations creating, 113–114
channels creating, 111–112
combining with gradients, 110–111
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O
Off option, for Size Jitter and Control, 88
oil painting, video, 45
On Black viewing mode, 71
On Layers viewing mode, 71
On White viewing mode, 71
Opacity Jitter and Control options, in Transfer tab, 91
Opacity setting, 93, 121
Opacity stops setting, in Solid Editor, 98
optical resolution, for scanners, 5
Options bar, 15
Options setting, in Noise Editor, 99
Outer Glow effect, 231
Output Module

contact sheets with, 268–269
PDF slide shows with, 270
Web Gallery component of, 271–272

overexposed skies, restoration of, 202–203
Overlay blending mode, 139
Overlay viewing mode, 71
overlays, cropping images and, 42

P
painting tools

in Brushes panel, 85–92
gradients as, 97–101
History Brush, 95–97
Mixer Brush, 94–95

panels, hiding/docking of, 19. see also specific panels
panoramic photos, creating, 132–134
Pantone colors, 81
Paragraph panel, 24, 220–221
Paragraph Styles panel, 222
Paragraph Text vs. Point Text, 213
Patch tool, repairing blemishes with, 186
paths

Pen tool creating, 68–70
placing text along, 224

Paths panel, 17, 292–293
Pattern Layers, 125
Pattern Overlay effect, in Layer Styles, 233
PDF (Portable Document Format)

Adobe standards, 280
compression methods, 281
compression options for Adobe, 279–280
output/security/Summary area of, 282

Pen Pressure/Tilt options, for Size Jitter, 89
Pen tool, 68–70
Pencil tool, 93
Perspective Crop tool, 46–47
perspective cropping, video, 46
Perspective option, in Free Transform command, 49
perspective planes, applying edits to, 207–208
perspective transformations, 54
Photo Filters, 159–160

M
Magic Eraser tool, 102
Magic Wand tool, 62, 63
Magnetic Lasso tool, 59–61
Marching Ants viewing mode, 71
Marquee tools, 56–58
Mask Edge button, in Properties panel, 115–116
masks. see also Layer Masks

attaching to layers, 107
Properties panel controlling, 18

Masks panel, 114
megapixels, 2, 3
memory card reader, downloading with, 31
Merge Layers command, 131
Merge to HDR Pro command, 261–262
Midpoint setting, in Solid Editor, 98
Mini Bridge panel, 24, 266
Minimum Diameter option, for brush size, 89
Minimum Roundness option, in Shape Dynamics tab, 89
Mixer Brush tool, 94–95
Mode setting, 52, 93, 130
modern image restoration, 180
monotone images, 7
Multichannel mode, 9
multiple layers

aligning, 127
auto-aligning, 134–135
Clipping Mask with, 129–130
distributing, 127–128
filtering view of, 130–131
grouping, 128
Layer Comps for, 136
locking, 128–129
merging/flattening, 131
selecting/linking, 126

Multiply blending mode, 139

N
Name criteria, in Filter Type menu, 130
Name setting, in Gradient editor, 98
Navigator panel, 20
negatives, scanners for, 32
New button, in Gradient editor, 99
New Document option, 73
New Document with Layer Mask option, 73
New Layer option, 73
New Layer with Layer Mask option, 73
New selection option, 57, 60, 62
Noise Editor, 98–99
noise, removing, 177, 204–205
nondestructive cropping, video, 45
nondestructive transforms, with Smart Objects, 53–54
Normal blending mode, 139
Normal Style option, for Marquee tools, 58
Note tool, in cropping images, 43
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Q
quadtone images, 7
quick mask mode, video, 68
Quick Selection tool, 61

R
Radial Gradient option, 100
Radius slider, for Edge Detection, 72
random fills, video, 125
raw files. see also Camera Raw

advantages of, 29–30
backup copies of, 31
opening with Camera Raw, 166
recovering, video, 155

readability of fonts, 210
Rectangle tool, 103
Rectangular Marquee tool, 42, 56–58
Red Eye tool, for photos, 187
Refine Edge command, 58, 60, 62, 71–73, 112
Refine Radius tool, 72
Reflected Gradient option, 100
resampling, 38–39
Reselect command, 63
resolution

dots per inch in, 3
with drum scanners, 33
image-sizing and, 37–38
lines per inch in, 5
optical vs. interpolated, 5
pixels per inch in, 4
ppi requirements for scanning, 33
for professional printing, 275
samples per inch in, 4–5
stock photo services and, 34

restoration, photo
of historical photos, 201
Lens Blur filter in, 205–206
overexposed skies and, 202–203
removing grain/noise, 204–205
Smart Sharpen filter in, 199–200
Vanishing Point plug-in for, 207–208

Result color, 138
retouching photos

Adaptive Wide-Angle Correction for, 197–198
Blur/Sharpen tools for, 190–191
Clone Stamp tool for, 181–182
Content-Aware fill option for, 188–189
Content-Aware Move tool for, 189–190
Dodge/Burn tools for, 193
Healing Brush tool for, 183–184
modern/historical, 180
Patch tool for, 186
Red Eye tool for, 187
Smudge tool for, 192
Sponge tool for, 194
Spot Healing Brush tool for, 184–185

Reveal Layer viewing mode, 71

photo,
effects, video, 233
tinting, video, 155

Photomerge command, 132–134, 261
Photoshop EPS file format, 284
Photoshop Manages Color method, 278
Photoshop (.psd) file format, 283
picture elements, 2
Pin Light blending mode, 139
pixel-averaging option, for Magic Wand tool, 62
pixel(s)

data, digital cameras and, 26–27
megapixels and, 2
origins of, 1–2
resampling of, 38
resolution and, 4
restoring, 45

pixels per inch (ppi)
computer screen resolution and, 4
scanning requirements, 33
shooting digital images and, 38

Place command, creating Smart Objects, 54
PNG (Portable Network Graphics), 286
Point Sample method, for color Sample Size, 83
Point Text vs. Paragraph Text, 213
Polygon tool, 103
Polygonal Lasso tool, 59
Portable Document Format (PDF). see PDF (Portable 

Document Format)
power crop, 44–45
presets

for Brush tool, 93
in Camera Raw dialog box, 177
for Crop tool, 46
in Layer Styles, 235–236
for type tools, 212

Presets setting, in Gradient editor, 97
Print command, 277–278
Print One Copy command, 279
printer categories, for desktop printing, 275
Printer Manages Color method, 278
printing

desktop, 275–276
dots per inch relative to, 3
professional. see professional printing

professional printing
CMYK Color mode for, 6
color separation/halftoning for, 274
high-resolution for, 3
Multichannel mode for, 9
quality of detail for, 275

Properties panel, 18, 115–116
Protect Texture option, 92
Protect Tones option, with Dodge/Burn tools, 193
PSB (Large Document Format), 285–286
public domain images, 35
Puppet Warp command, 51–53
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sensors, photosensitive electronic, 25–26
sepia-toned photo restoration, 201
sepia tones, creative, video, 158
serif font vs. sans serif font, 211
Shadows/Highlights command, 160–161
Shape Dynamics tab, in Brush Presets, 88–89
shape layers, 106
shapes

creating/loading custom, 104
drawing, 105–106
three ways of creating, 106
tools for drawing, 103–104

Sharpen tool, 190–191
Shift Edge slider, with Refine Edge command, 72
Show All Channels view, in Histogram panel, 21
Show All Menu Items command, 260
Show Original option, 72
Show Radius option, 72
Similar command, 64
Single-line Composer option, in Paragraph panel, 221
Single Row/Single Column Marquee tools, 56
Size Jitter and Control options, in Shape Dynamics tab, 

88–89
Size option, in Brush Tip Shape tab, 87
sizing digital images

Canvas Size dialog box in, 41–42
Content-Aware scaling in, 51
Crop tool and, 42–44
Free Transform command in, 48–50
Image Size dialog box in, 40–41
Perspective Crop tool in, 46–47
power crop and, 44–45
Puppet Warp command in, 51–53
resampling for, 38–39
resolution and, 37–38
Rotate Canvas command in, 47–48
Smart Objects and, 53–54

Skew option, in Free Transform command, 49
skies, overexposed, 202–203
Skin Tones option, 67
slide scanners, 32
slide shows, Output Module creating, 270
Smart Filters

for color correction, 146
features of, 243–244
Layer Masks with, 244

Smart Objects
adding flexibility, 122
alternate path to, 54
grouping multiple layers into, 131
nondestructive transforms with, 53–54

Smart Radius option, 72
Smart Sharpen filter, 199–200
Smooth command, 64
Smooth slider, with Refine Edge command, 72
Smoothing option, 92
Smoothness setting, in Solid Editor, 98

RGB Color mode
in Bayer filters, 26
for desktop printing, 275–276
for filtering, 241
for Photoshop/computer monitors, 6

Rotate Canvas command, 47–48
Rotate option, in Free Transform command, 49
Rotate View tool, 48
Rotation option, for Size Jitter, 89
Roughness setting, in Noise Editor, 99
Rounded Rectangle tool, 103
Roundness Jitter and Control options, in Shape Dynamics 

tab, 89
Roundness option, in Brush Tip Shape tab, 87
royalty-free images, 34

S
Sample All Layers option, 62, 181–182
Sample Colors option, 67
sample, defined, 4
Sample Size option, for Magic Wand tool, 62
samples per inch (spi), 4–5, 32
sans serif font vs. serif font, 211
Satin effect, in Layer Styles, 232
Saturation blending mode, 140
Saturation Jitter option, in Color Dynamics tabs, 91
Save Adobe PDF, Compression settings in, 281
Save For Web command, 288–290
Save Tool Presets option, 46
Scale option, in Free Transform command, 49
Scale to Fit Media check box, 278
scanners

optical resolution for, 5
ppi requirements for, 33
samples per inch and, 4–5
types of, 32–33

Scatter and Control options, 89
Scattering tab, in Brush Presets, 89–90
Screen blending mode, 139
scripts

function of, 247
Image Processor command for, 263–264
Layer Comps for, 265

security, for PDF format, 282
selecting multiple layers, 126
Selection commands, 63–65
Selection option, with Refine Edge command, 73
selection saving/reloading, 68
selection techniques

advanced, 74–78
advice on, 78
intermediate, 65–73

selection tools
Lasso, 59–61
Marquee, 56–58
need for, 55
Patch, 186
Wand, 61–63
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Transfer tab, in Brush Presets, 91
Transform Selection command, 64
transform smart objects, video, 53
tritone images, 7
Type Enhancement buttons, 214–215, 218–219
type, role of, 210
type tools

applying styles, 222–223
Character panel in, 214–220
filtering text, 226
font choice, 210–212
Free Transform command as, 223–224
Layer Styles as, 225–226
in Paragraph panel, 220–221
placing text on paths, 224
using vectors, 212–213
Warped Text as, 225

U
UI Font Size, adjusting, 13
Unconstrained option, in cropping images, 44
upsampling, 38
Use Classic Mode option, for cropping images, 43
Use Sample Size option, in Brush Tip Shape tab, 87

V
Vanishing Point plug-in, 207–208
vector drawing tools, 103–106
Vector Shape layer, 49
vector tools

creating paths with, 17, 224
for type, 212–213

vertical scale for type, 217
Vertical Type tool, 212–213
Vibrance adjustment, 154, 156
video files, editing, 22–23
view, for filtering images, 240
Vignette Removal option, in Photomerge, 133
visual scripting, with Actions panel, 22
Vivid Light blending mode, 139

W
Wand tools

Magic Wand tool, 62–63
Quick Selection tool, 61

Warp option, in Free Transform command, 50
Warped Text dialog box, 225
warping layers, 51–53
Web Gallery component, of Output Module, 271–272
Wet Edges option, 92
Width option, for Magnetic Lasso tool, 60
Workspace switcher, 15

X
x-height, in font choice, 211

Smudge tool, 116–117, 192
snapshots, 96, 177
soft focus, correcting, 199–200
Soft Light blending mode, 139
Solid Color Layers, 125
Solid Editor, 98
Spacing option, 88, 221
specialized file formats, 283–288
specialized processes, 288–293
spell check, in Character panel, 215, 219
spi (samples per inch), 4–5, 32
Split Toning controls, in Camera Raw, 174
Sponge tool

adjusting saturation/contrast, 194
Lens Corrections filter for, 195–196

spot color channels, 
file formats for, 285
video, 81

Spot Healing Brush tool, 184–185
stock photo services, 34, 35
Stop Editor setting, 98
Straighten button, for cropping images, 44
Stroke effect, in Layer Styles, 230
style, font, 210
Styles panel, 19
styles, type

applying, 222
overriding/reusing, 223

Stylus Pressure option, for Magnetic Lasso tool, 61
Stylus Wheel option, for Size Jitter, 89
Subtract blending mode, 140
Subtract from selection option, 57, 60, 62
Summary area, in PDF format, 282
Swatches panel

Color Libraries in, 81
features of, 19
keyboard shortcuts for, 84

T
Tagged-Image File Format (TIFF), 287
Targa format, 287
text color setting, in Character panel, 218
text, working with. see type tools
Texture tab, in Brush Presets, 90
third-party actions, 250–251
third-party filters, 240
Tilt Scale option, for pen/stylus, 89
Timeline panel, 23
tinting, photo, video, 155
Tolerance option, for Magic Wand tool, 62
Tone Curve tab, in Camera Raw, 171
tool presets, for Crop tool, 46
Tool Presets option, for Brush tool, 93
toolbar, Camera Raw, 169
Tools panel, 12–14, 56
tools, switching, video, 12
tracking adjustments, 216–217
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